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ACTIVITY QUESTIONS OUTPUT
Choose Site Goals Why am I building this site?


What do I hope to accomplish?


 Mission Statement


Identify Audience Who will be using the site? List of User Types


Define Each User Type Why would users come to the site?


How will they use the site?


Outline of User Goals


Determine Content What will users want from the site?


What kinds of content is appropriate?


List of Content Objects


Information Architec-
ture


What are the larger areas of content 
and how do they fit together?


How should the content be structured?


Should I explore metaphors?
(organizational, visual, functional) 


 Site Map


Page Design What information needs to
be on each page?


What needs to be on all pages?


How should by navigation be layed 
out?


Wireframes of all Pages


Visual Design What is the emotional tone of this site?


What is the “brand” of this site?


Design Comps
(Look and Feel)


Technical Design Are there any technical considerations 
that need to be taken into account (i.e.
browser support)?


List of Technical Requirements


Development What’s the easiest way to build and 
maintain this site?


Web Site


User Testing Is site fulfilling user’s goals?


How can it be improved?


Final Web Site


User Centered Design Methodology







REAL-WORLD QUESTIONS


This client needed a re-design fast.  He inherited a poorly-designed website and had 3 days to get 
it up before the organization’s first big event.  Below is some Q & A.  These are the types of ques-
tions you should ask yourself and your future clients. 


 1.  What is the organization’s name to go on website.  (Charleston Alabama Alumni Chapter?, etc) 
Let’s go with Lowcountry Crimson Tide Chapter but make sure to mention Charleston and the surroud-
ing area in there somewhere.   


 2.  What are the officers names and emails (if you want that info displayed)?  To make it easy we 
could just leave the secondary page called “staff” but maybe change the name to “leadership” in-
stead.  I will poll this people on this page and see if they want to be active (I have never even heard of 
some of them).  I will also ask the other officers if they want their email address included on the web-
site.  What do you think?


3.  Describe your organization.  Is there a mission statement?
The Lowcountry Crimson Tide Chapter exists to support the University of Alabama and strengthen the 
connection among the over 400 area alumni as well as family and friends in the Lowcountry.  
 


4.  What do you want the viewer to come away with after viewing the website?  We want them to 
know we are here in Charleston, Active, Want their participation, and where they can find us. 


5.  What color(s) best describe(s) this organization? Why?  Crimson and White because they are 
the school colors.  Also green is the color of the palmetto trees in the lowcountry


6.  Do you have any texts, logos, photos, or video that can appear on the site?  see letterhead I sent 
over with palmetto tree and A insignia


7.  Who is your audience?  Alabama fans/alumni who are looking for a game watching location, folks 
looking for a local connection to Alabama that are moving to the area, or folks looking for local up-
dates on what the chapter is doing.


8.  Has anyone created a similar website that you know of? See Atlanta and New York Chapters.  
Here is the chapter in Columbia, SC that got the out of state chapter award last year.  Pretty clean 
and simple.  http://bamachapterofthemidlands.com/index.htm


9.  What image do you want to portray? (professional, casual, etc)  Fun! and informative


10. If you have branding what colors, fonts, styles do you use?  Crimson and White


11. What absolutely must be on the homepage?  Open to your ideas.


12. Anything you DON’T want on your site?  no nudity or profanity








SMARTOBJECTS IN DREAMWEAVER


New in CS4, you can choose a Photoshop (PSD) file in the Select Image Source dialog, then 
place it into Dreamweaver.  It is copied and placed into Dreamweaver in JPEG, GIF, or PNG 
format as a SmartObject, which maintains a link to the original Photoshop .psd file.  When the 
.psd file is updated, Dreamweaver recognizes the changes and offers to update the copy in the 
Dreamweaver document.  You might want to create separate PSD’s for your navigtion.


The benefit of the SmartObject approach is that you can have a single .psd file that is used in 
many different pages of your site.  When you update the Photoshop file, you can update all the 
different copies of the file throughout your site at once.  


It is good practice to keep your PSD’s in an “assets” folder along with other media (except for your 
web graphic images which should reside in the “images” folder).  


EXAMPLE:  I want to insert an image into the gap below.  This gap is also a div.


To Create a SmartObject:


1.   Click in the area (div or table) in which you want to insert the image.  
2.  Go to up to “Insert” then to “Image.” “
3.  In the “Select Image Source” window make sure you are within your Site Folder.  This is very  
     important.  If the file you’re looking for is somewhere else you will need to put it in your Site  
     Folder.
4.  Navigate to your PSD and click “Choose.”


GAP







5.  This will open an “Image Preview” dialog box which is very similar to the “Save for Web 
and Devices” dialog box in Photoshop.


**A diagram of the “Image Preview” dialog box is in your textbook pgs 149-150.


6.  Once you have decided on your image format and compression you will be asked to 
save the file.


You will want to save the file in you Site Folder.  A shortcut for making sure you are in your 
Site Folder is to click on “Site Root.” 


You will then want to save the file in your Images Folder


You will be asked to type in “alt” text.


Then your graphic will appear!!


The green circle indicates that this graphic is a SmartObject.  It also tells me that this 
version of the graphic is in sync with the original .psd.  


You can now apply this graphic to many pages.







What if you or your client wanted to change the color and/or text of this graphic?


EASY.  You can use the new SmartObject technology to quickly change the graphic for all the pages 
it appears on for this site. To do this Dreamweaver will send you to Photoshop.


TO EDIT A SMARTOBJECT IN PHOTOSHOP


1.  Select the graphic you want to change.


2.  Go down to the edit field of the Properties Inspector.  There you will see a tiny Photoshop  
      icon.


3.  Click the icon.  Your .psd, which is the source file for this graphic, will be opened in    
     Photoshop.


4. In your layers panel you should see all of the text, 
backgrounds, and any “up” and “over” layers you might
have made.  Make your changes.


5.  Save your file by holding down Command + s or going
to File > Save.


6.  When you go back to Dreamweaver you will see a change in the circle icon on your 
graphic.  It will now be green AND red.


This indicates that the GIF is out of sync with the PSD file you just changed.


7.  To syncronize Control + click on the icon.  This 
will bring up the following menu.  Select “Update 
From Original”


This will cause Dreamweaver to go back to 
Photoshop and re-optimize the file from the 
original PSD file without having to redo everthing.


The graphic should now be updated across your website!!







COPY/PASTE TECHNIQUE


Another way of bringing Photoshop graphics into Dreamweaver is to “Copy and Paste” them from 
yourWebsite Mock-up PSD.


This is useful if you do not want to make separate PSD’s for specific areas of your website such as 
navigation, buttons, etc.


1.  Select the Layer Group (or Layer if all of the content you want is in that layer) you are working 
in and use the Rectangular Marquee Tool          to make a selection over the part you want to copy.  


2.  To copy all of the layers within that selection 
go up to “Edit” then to “Copy Merged.”


3.  Then delete the selection by going up to 
“Select” them to  and then “Deselect.”


4.  Go back to Dreamweaver and select the area in which you want to paste your content.


5.  Go up to “Edit” and choose “Paste.”


6.  That opens up Dreamweaver’s “Image Preview” dialog box which is very similar to Photoshop’s 
“Save for Web and Devices” dialog box.  


7.  Optimize your content per usual.


8.  You will be prompted to save your image.  Make sure you are in your Site Folder.  You will likely 
save the file in your images folder.


9.  That’s it!  The folder now appears in your Dreamweaver page.


ADVANTAGES AND DISADVANTAGES


Advantage:  You can copy and paste from your Website Mock-up PSD instead of making multiple 
PSD files


Disadvantage:  The downside to “Copy and Paste” is that if you want to modify your image you 
can’t make use of the SmartObject “roundtrip” editing.  You must must delete the graphic out of 








SLICING in PHOTOSHOP


What are slices?


Slices divide an image into smaller images that are reassembled on a web page using an HTML 
table or CSS layers. By dividing the image, you can assign different URL links to create page 
navigation, or optimize each part of an image using its own optimization settings.


You export and optimize a sliced image using the Save For Web & Devices command. Photoshop 
saves each slice as a separate file and generates the HTML or CSS code needed to display the 
sliced image.


When you work with slices, keep these basics in mind:


    *  You can create a slice by using the Slice tool or by creating layer-based slices.


    *  After you create a slice, you can select it using the Slice Select tool  and then move, resize, or  
       align it with other slices.


    *  You can set options for each slice—such as slice type, name, and URL—in the Slice Options  
       dialog box.


    *  You can optimize each slice using different optimization settings in the Save For Web &       
       Devices dialog box.


Best Photoshop Settings for Slices


1.  Make sure “Snap” is enabled.  Go to View on the top and then to “Snap.”  
There should be a checkmark beside “Snap.”  This will help you to line up all of 
the slices as you create them.  The slices will snap to one another and also to the 
underlying artwork.


2.  Make sure you can see your slices.  
Go to View on the top and then to “Show.”  


From there make sure there is a checkmark 
beside “Slices.”


3.  Set the color of the slice lines.  The default is light blue.  This is done in Photoshop Preferences.  
Go to Photoshop on the top > Preferences > Guides, Grid, & Slices.  To the right of “Slices” you will 
see line color.  Pick a color that will stand out against your background.







TYPES of Slices


User Slices are the slices you make yourself.  Auto Slices are slices Photoshop makes for you.  
Layer-Based Slices are a special kind of user-based slice.


CREATING USER SLICES


1.  Go to the toolbar and select the “Slice Tool.”  The “Slice Tool” by 
default shows the “Crop Tool.”


2.  Draw slice around a specific area such as a logo or button.  When you release you will see a 
blue line appear around the slice.  


One of the ways we know it is a user slice is 
by the blue number and a blue icon (see red arrow).


If you look carefully you will see there are other 
slices here as well.  These slices have gray 
numbers and gray icons.  Those are auto slices.


Every time you make a slice Photoshop 
automatically runs behind you and makes auto 
slices to fill in the rectangular spaces around the 
rectangulary slice you have made.  (see green 
arrows)


ADJUSTING WIDTH and HEIGHT


You can adjust the borders on a user slice with the “Slice 
Select Tool.”


You cannot adjust the borders on auto slices.  If you want to adjust the borders on an auto slice 
you must convert it to a user slice.  


To do this you use the “Slice Select Tool” and 
select the slice you want to convert.  You then 
go up to the tool’s options and click “Promote.”


Now you can adjust the height and width and
have created a new slice at the same time.  


 
DELETING User Slices
To delete a slice select it with the “Slice Select Tool.”  


CTRL + Click on the slice and select “Delete”


You can clear all slices by going to View > Clear Slices







DIVIDING UP SLICES


Beneath you see a user slice I have made around my button navigation with the “Slice Tool.”


I could go in and draw new slices over all of my buttons however sometimes it is faster just to go in and 
divide up the slices you have already made.


1.  To divide, take the “Slice Select Tool” and select 
the slice you want to divide.  Then  go up to the tool’s 
options and click “Divide.”


2.  In this dialog box you can select how 
many rows, columns, and how you want the 
slices to be divided.


3.  Now you see 3 slices around the buttons.  You can use the “Slice Select Tool” to click and drag the 
borders to wherever you want them.


COMBINING SLICES


1.  Using the “Slice Select Tool” and holding down the Shift key click on all of the slices you want to 
combine.


2.  When all of your slices are selected CTRL + Click and you will 
get the following menu.  


3.  Select “Combine.”







CREATING LAYER-BASED SLICES


Layer-based slices are user slices you can create automatically based on the content of layers.  
These are the easiest slices to make and have some useful advantages over slices made with the 
slice tool.


But remember layer-based slicing only works if you’ve had the foresight to build individual pieces 
of artwork (buttons, logo, header, etc) on separate layers.


To Create a Layer-Based Slice:


1.  Select a layer in your layers panel


2.  Go up to Layers and select “New Layer-Based Slice.”


3.  You can create more than one layer-based slice at a time by holding down the shift key to 
select multiple slices.  Then go up to Layers and select “New Layer-Based Slices.”


ADVANTAGES of Layer-Based Slices


1.  Layer-based slices stay “attached” to the content.  You can use the “Slice Select Tool” to select 
a slice and then use the “Move” tool to relocate the slice with the content of the layer.


2.  Layer-based slices will change size to matach the content in the layer.


3.  If you add an fx such as a “drop shadow” to a layer after you’ve made your slice, the slice will 
expand to accommodate the fx.


SLICE OPTIONS:


1.  Naming your slices.  Since you will be exporting your slices as jpegs, gifs, and pngs it is vey 
important you give them names so you’ll know what they’re meant for bringing them into 
Dreamweaver


 a.  Select a slice with the “Slice Selection Tool”
 
 b.  On the top toolbar find this icon on the right.


 


 c.  You will see the dialog box on the next page.







 d.  The most important thing in the “Slice Options” dialog box is the Name.  The titles of  
 slices are automatically generated as the title of the document with the slice number.  


 Unless you give the slice a name such as “logo,” “header,” “contact_button,” or even   
 “contact_roll” (to indicate it is the rollover image) your images will get lost in    
 Dreamweaver.


VERY important!


 optional
(not important)


 The reason the other text fields are optional is because you will do all of this in    
 Dreamweaver.  They are only helpful if you want to preview non-rollover links with the   
 Preview button on Save for Web and Devices dialog box.


EXPORTING YOUR SLICES FOR DREAMWEAVER
In general you should only export your user and layer-based slices (blue) and not your auto slices 
(gray).  This is because the area of the auto slices won’t be graphics, they will be things like 
background color and text.  


1.  Go to File > Save for Web and Devices.  


2.  You will want to use the “Optimized” view as opposed to 2-up and 4-up.  This is so you can see 
most of your page at once.


3.  Using the “Slice Select Tool” you can click on each slice to set the export settings (file type, 
quality, etc) or select several slices with Shift + Click to apply the same settings (ex. buttons)


4.  Another nice tool in the “Save for Web and Devices” dialog is this button.
It toggles between invisibility and visibility of the slices and background so you can look at colors 
better.







5.  THE EXPORT.  When you hit “Done” it will take 
you to this familiar dialog box. 


Make a new folder to save your images into.  I 
would recommend saving them in your Images 
folder OR making a subfolder in your Images folder.   


 


Here are 2 ways of exporting slices:


a.  Save ONLY the slices you want to use for graphics for your website in Dreamweaver.


This option gives you Images Only (no HTML 
code generated).  


You can then select if you want to use ALL of the 
User Slices (Blue) or only Selected Slices (which 
would make sense if you were only working on 
your logo for example). 


b.  Save ALL SLICES, including the auto slices, and Photoshop will generate a HTML file which contains 
the code to reassemble all of the images when viewed in a browser.


Now I have an HTML file outside of my folder with all of the slices.  


If I open the HTML file in a browser (or Dreamweaver) all of 
the images will now be assembled into a complete web page.  
You would never want to have a web page only consisting of 
images but this can be helpful for previewing.  


6.  Now your slices are ready for Dreamweaver!  You have saved yourself a lot of time since you did your 
Mock-up in Photoshop.  You can always go back and tweek your PNG’s and GIF’s in Photoshop.








WEEK SEVEN : Putting it all together in Dreamweaver (MAR 8th)


Merging your Mock-up with Dreamweaver using Slicing, Smart Objects, and Copy & Paste


SLICING


 Settings


 Types of Slices:  User, Auto, Layer-Based


 USER and LAYER-BASED Slices


 


  Creating


 


  Adjusting


 


  Deleting


 


  Combining


 


  Naming


 EXPORTING Slices for Dreamweaver


 


  User Slices only


 


  All Slices + HTML


MERGING PHOTOSHOP WITH DREAMWEAVER


 SmartObjects


 


  Creating


  Editing


 Copy & Paste Technique


 


OVER







IN-CLASS:  


Start working on your midterm.  We have already gone through the prelimary Site Planning Stage.   Next:  


FIRST:  Decide how you want to organize your files.  Structure and organization is the key!!


SECOND:  Prepare the assets you will be using in Dreamweaver.  This can start with slicing your mock-up and 


working on other items in Photshop.


THIRD:  Start bringing these elements into Dreamweaver.  If divs are still confusing you (which is ok) can use 


a template from Dreamweaver.  You might also want to try the SmartObject or Copy and Paste technique.


Begin INDIVIDUAL MEETINGS / Show me your Mock-Up


Requirements for midterm site:


 1. 5-10 pages linked 


 2. rollovers 


 3. css linked stylesheet 


 4. navigation bar or system that is easy to navigate


 5. design of site that is distinctive


**Note:  You can still make a distinctive design by modifying a template.  Chapter 15:  Making Life Easier, Us-


ing Templates, Libraries, and Snippets


RESOURCES:


 Creating your own CSS Layouts:


 http://www.maxdesign.com.au/articles/css-layouts/


 Exporting your Mock-up into  a CSS Layout with Fireworks
 http://www.adobe.com/newsletters/edge/june2009/articles/article6/index.html?trackingid=ETHYB


 (there are many tutorials on how to do this online)


 


 Textbook:


 Chapter 5:  Including Images and Media 


HOMEWORK:  Continue working on your site and mock-up for next week.


NEXT WEEK:


Creating our layout in Dreamweaver and Navigation Options:  show and hide, vertical gallery, thumbnail 


contruction, image mapping


Many of you will want to incorporate these navigation items into your site.  You can jump ahead and lay the 


groundwork  by preparing some of these items in Photoshop.  I encourage you to start planning for these by 


reading:  Chapter 13:  Using Behaviors and Navigation Objects





